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1 Introduccién

En este manual se describen los distintos aspectos que debe conocer el usuario sobre QuickREX y sobre
su integracion con Eclipse.

2 Conceptos basicos

QuickREX es un plug-in para Eclipse que tiene como objetivo ayudar en la creacién y comprobacion de
expresiones regulares.

El uso de expresiones regulares dota a una aplicacion de mucha potencia, pero en ocasiones puede
llevar a la confusion. QuickREXx ha sido desarrollado para ayudar a la creacién de las expresiones regulares,
permitiendo la comprobacién de las mismas sobre textos de pruebas.

QuickREXx da la posibilidad de incluir en Eclipse dos vistas, una para la creaciéon y comprobacion de
expresiones regulares y otra con una serie de expresiones regulares ya definidas que pueden ser muy (utiles.
Ademas es capaz de trabajar con varias implementaciones de la maquina virtual java.

Desarrollado por Bastian Bergerhoff, mantiene el proyecto a través de la comunidad de SourceForge,
pudiendo acudir a su pagina web o a la de SourceForge.

En el momento de escribir este documento la Gltima version disponible del plug-in es la 3.5.0.
Puede encontrarse informacion adicional sobre el producto, en la pagina web oficial:

http://www.bastian-bergerhoff.com/eclipse/features/web/QuickREx/toc.html

o a través de SourceForge, en:

http://QuickREXx.sourceforge.net/

3 Integracion con Eclipse

Al igual que en otros muchos casos, la integracion de QuickREx con Eclipse ofrece un entorno de trabajo
visual, comodo y facil de usar durante los desarrollos. QuickREx da la posibilidad de afiadir dos vistas y un
editor al entorno de desarrollo (Perspective).
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3.1 Vista de biblioteca de expresiones regulares (R  eg. Exp. Library))

En esta vista aparecen las expresiones regulares almacenadas, con su explicacion y textos de prueba. Al
instalar el plug-in se incluyen unas cuantas expresiones regulares muy (tiles.

£

=h.
=,

= B QuickREx
=L Miscellaneous
[ L] WML, HTML, ete
[= L IP-Addeesses ebc
RE IP-Address wio capturing groups
RE Tp-Address with captunng groups
B Test
RE Leading whitespace
RE Traiing whitespace
RE Leading or traling whitespace
RE Lines containing FOO"
RE Lines containing 'FOO" and ‘BAR'
RE 'FOC" and BAR' 'close to each other'
I RE Complex containement
5 L Dates
RE Yahd dates, yyyy-mm-dd
RE Yahd dates, dd-mm-yyyy
=45 Numbers
R isnber vaith 1. 000-dedmi
RE Positive decimal number
E Floating point number

R R

Para incluir esta vista en el entorno (perspectiva) activo, acceder al menu “Window-> Show View >
Other...”

| Window Help
'h'\'c‘rr-"l.'u L3-|G'|ﬁv0-q.
AR4Shift+Q, C
Alkc+Shift+C, T
A+ Shift+Q, P

En la ventana que aparece acceder al apartado QuickREXx y hacer doble clic sobre el elemento “Reg. Exp.
Library”.
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Aparece una nueva pestafia en uno de los paneles de vistas inferiores, con el titulo “Reg. Exp. Library”.
Se recomienda recolocar dicha pestafia en el panel superior izquierdo, el de navegacion. Para ello pinchar sobre

la nueva pestafia y sin soltar arrastrar con el ratén hasta el panel superior izquierdo. Una vez que aparezca un
recuadro que indica la posicion deseada soltar el raton.
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MyEclipse Java Enterprise - Eclipse Platform

= B QuickREx
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3.2 Vista de comprobacion (QuickREX)

En esta vista se puede construir y probar las expresiones regulares.

= QUIREX 5

b

Regular Expression: | [-+]2(7:(2:(1-0\HD, ZH(7:\. \did\d)*)|0), 2} 1) =] |Ed...
Test-Text:

+ Evaluation Details

B Live-avaluation | & % | Matcher.makehes() s Talse'
Matches: 5, current is from 0 to 12
Groups: 5 none

» Global Flags

Para incluir esta vista en el entorno activo, acceder al menu “Window—> Show View - Other...” del
mismo modo que en el caso anterior. En la ventana que aparece acceder al apartado QuickREx y hacer doble
clic sobre el elemento “QuickREX".

& Show View x|
[tvpe filter bext
(= MyEclipse AIAR -

G

= MyEclipse Commen

= MyEclipse Database

(= MyEclipse Java Enterprise

(= MyEclipse Report Design

- MyEclipse Swing

- Mylyn

#-(= FDE

| L=+ PDE Runtime

B QuickREx
3 REX
% Reg, Exp. Library

= SN

®-(= Team

= vss

e B8
4

m
.

4 o

=
I

Aparece una nueva pestafia en el panel de vistas inferior izquierdo, con el titulo “QuickREX". Se
recomienda recolocar dicha pestafia en el panel de vistas inferior que esta situado en el centro. Para ello pinchar
sobre la pestafia afiadida y sin soltar arrastrar con el ratén hasta el panel central. Una vez que aparezca un
recuadro que indica la posicion deseada soltar el raton.
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4 Utilidad Practica

QuickREX es una herramienta muy potente para la creacién y prueba de expresiones regulares.

Trabaja con las librerias de uso de expresiones regulares mas comunmente utilizadas en el mundo Java.
« JDK Regular Expressions (disponible desde la versién 1.4 del JDK)
« Jakarta ORO Perl-style Regular Expressions (ORO-Version 2.0.8 soporta Perl 5.003 Regular
Expressions)
« Jakarta ORO Awk-style Regular Expressions (ORO-Version 2.0.8)
« JRegex Regular Expressions (La version 1.2_01, soporta Perl 5.6 Regular Expressions)
« Jakarta-Regexp Regular Expressions (Versién 1.4)

Para cada una de estas librerias es posible configurar los flags de uso desde la vista que ofrece el plug-in
QUuickREXx o bien pueden ser activados en linea utilizando las opciones de la misma expresién regular, siempre,
claro esta, que la implementacion dada lo soporte.

En los siguientes puntos se explicara en detalle toda la funcionalidad que ofrece el plug-in.
4.1 Biblioteca de expresiones regulares

La vista con la biblioteca de expresiones regulares (Reg. Exp. Library) se afiadié en la version 3 del plug-
in. Es una herramienta que permite almacenar, organizar y buscar expresiones regulares de uso coman.

Pueden organizarse segun temas, por ejemplo: literales, fechas, numéricas, etc. Ademas la vista ofrece la
posibilidad de realizar blsquedas a través de las expresiones almacenadas.

4.1.1. Estructura de la biblioteca

La biblioteca de expresiones regulares contiene ‘Libros ' los cuales contienen ‘Categorias ' donde se
almacenan las ‘Definiciones de expresiones regulares '

Con la instalacién del plug-in se incluye un libro por defecto llamado ‘QuickREX’. Este libro es de sélo
lectura, no se puede afiadir, modificar o borrar los elementos del mismo.

B d

== Req, Exp, Library 3 Q:D | li;E' =
2 B QuickREx -&————"Libro

F-LE Miscellaneous .
e Categoria

[E] %ML, HTML, etc

i | IP-Addresses etc

L] Text

l—| | Dakes

1-L[E) Mumbers

RE Mumber with 1.000-delimiter{s)

RE Paositive decimal number e

RE Floating point number g———" Definicidn
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4.1.2. Labiblioteca inicial: QuickREXx

La biblioteca que viene por defecto con el plug-in puede utilizarse como punto de partida para crear
nuevas expresiones regulares. Sus elementos: categorias y definiciones, no pueden ser modificados utilizando
los accesos directos que ofrece el plug-in, pero dichos elementos son definidos en un fichero xml, por tanto
puede ser adaptado a las necesidades de uno mismo. En cualquier caso, como el plug-in ofrece la posibilidad
de crear nuevos libros, no es necesario modificar el que viene por defecto.

La siguiente figura muestra el contenido de la biblioteca que se instala por defecto con el plug-in:

e

Y

CuickRE>x
LE| Miscellaneous
RE 1SBN-Mumbers
RE Mastercard-numbers
E-LF] XML, HTML, etc
RE Tags (1)
RE Tags (2)
RE Tags (3)
RE Empty tags
=17 IP-Addresses etc
RE 1P-Address wio capturing groups
RE IP-Address with capturing groups
E-LE Text
RE Leading whitespace
RE Trailing whitespace
RE Leading or trailing whitespace
RE Lines cortaining ‘FOO"
RE Lines containing 'FOO" and 'BAR
RE 'FOO" and 'BAR' 'close to each other”
RE Complex containement
217 Dates
RE Yalid dates, yyyy-mm-dd
— RE Valid dates, dd-mm-yyyy
=47 Numbers
RE Number with 1,000-delimiter(s)
- RE Positive decimal number
RE Floating point number

4.1.3. Creacion y gestion de libros

Para afiadir un nuevo libro a la biblioteca desde el que gestionar nuestras propias expresiones regulares,
acceder al menu: “File> New > Other...".
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¥ XML (Advanced Templates)
|¥| XML {Basic Templates)
(S} #ML Schema

Exit

W UML Moded Reposttory

i=-L7) Mumbers
RE Wumber with 1.000-debmiter(s)
RE Positive decimal number
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En la ventana que aparece buscar el apartado ‘QuickREX’ y hacer doble clic sobre ‘Regular Expression

Book...”, tal como se muestra en la figura:
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€ rew o BY
Select a wizard
Create & file holding a book in your QuickREx Regular Expression Library

Wizards:
feype filter text

™ = General =
= v

¥ [= Edlipse Modeling Frameswork.

¥ = Example EMF Model Creation Wizards
B = Jawa

#-l=> Jawa Emitter Templates

#-[= MyEdipse

B2 Mylyn

@ (= Plug-in Development

B2 %ﬁ:kksx

=y SYN
1= User Assistance

B-m

Led

[ Show All Wizards,

7] < Bk | et > I Fanisty l Cancel |

En la ventana que aparece, indicar el fichero xml dénde se almacenara la informacion del libro y el
nombre que se desea que aparezca en la vista de biblioteca.

CEEE——— o
Regular Expression Book

This wizard creates a fle holding a book in your QuickREx Reguiar
Expressian Library

Fle path: | elpluginside babe. aclpse. plugins QuickREx_3.5,0\Milibro.xanl | Browse...
Book name; | MiLibro]

@) <pack | oo [ Eosh || conel |

Por dltimo pulsar ‘Finish’. Deberéa aparecer el libro creado en la vista de biblioteca, como muestra la

14/22



siguiente figura:

# B QuickrEx

SR i

ibra

A diferencia del libro por defecto que se incluye en la aplicacién, cualquier otro que creemos nostros

EJie

mismos podra gestionarse desde la vista de biblioteca incluida en el plug-in.

4.1.4. Gestionando un libro

Eusko i Informatika Elk
Sociedad Informatica del Gobierno Vasco

Para crear una categoria pinchar sobre el libro en el que se va a crear, pulsar el botén derecho del ratén y
en el menud contextual que aparece, seleccionar ‘Add catgegory...’, tal como muestra la figura.

[

-8
g

En la ventana que aparece, indicar el nombre de la categoria y pulsar ‘OK’.

& Enter category-name 1

Please enter a name For the category

x|

| Alfanuméricos|

oK

Cancel

Debera aparecer en la vista tal como muestra la figura:
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Desde el menu contextual que aparece cuando esta seleccionado el libro se puede:
« Afadir categoria. (Tal como se acaba de explicar).
e Cambiar el nombre del libro.
e Cambiar la ruta del fichero xml que define el libro.

< Borrar el libro. Esta accién eliminara todos los elementos (categorias y expresiones regulares)
incluidos en el libro.

4.1.5. Almacenando una expresion reqular

Para crear una expresion regular pinchar sobre la categoria dentro de la que se quiere crear, pulsar el

boton derecho del ratén y en el menl contextual que aparece, seleccionar ‘Add Reg. Exp. entry...’, tal como
muestra la figura.

[ X
[+ @, QuickREx
=- MiLibro

Add Req. Exp. entry...

Rename category, ..

Delete category

En la ventana que aparece, indicar el nombre que se le quiere dar a la expresion regular y pulsar ‘OK’.

£ Enter title B x|

Please enter a title for the entry
| IF]

[ x ] coe

Debera mostrarse en la vista tal como indica la figura:

16/22



— Eusko Jaurlaritzaren Informatika Elkartea
le Sociedad Informatica del Gobierno Vasco

I,

|=+ Reg, Exp. Library &3
#- ] QuickREx

= E miibro
=47 Afanuméricos

RE

Ademas al crear la definicién de una expresion regular se abre en la zona de edicion, la ventana de

edicién de la expresion regular que queremos definir. La ventana de edicion de expresiones regulares se
explicara en el siguiente punto de este mismo manual.

Desde el menu contextual que aparece cuando esta seleccionada una categoria se puede:
< Afadir expresion regular. (Tal como se acaba de explicar).

« Afadir categoria. Se posicionara inmediatamente después de la categoria seleccionada.
e Cambiar el nombre dado a la categoria.

< Eliminar la categoria seleccionada. Esta accién eliminara todas las definiciones de expresiones
regulares incluidas dentro de la categoria.

4.1.6. Trabajando con expresiones requlares

Cuando se pincha con el raton en una expresion regular creada en un libro que no sea el que viene por
defecto con el plugin, aparece el siguiente menu contextual:

(= L] Alfanuméricos

RE

'l Tags HT Add Req. Exp. entry. ..
2 TagsHT Edit...

Delete, ..
Use in QuIckREx-Yiew. ..

Ademas de dar la posibilidad de afiadir una nueva expresion regular, este mend nos permite con la
expresioén regular seleccionada:

< Editar (Edit...): Muestra la informacion existente en el panel de edicion de QuickREX y permite
modificarla.
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Jiie i | | |

Eliminar (Delete...): Elimina la expresion regular de la categoria en la que se incluy6.
Utilizar en la vista de pruebas de QuickREXx (Use in QuickREx-View...): Traslada la expresion
regular y el texto de prueba a la vista en la que se puede probar el correcto funcionamiento de la

expresion regular.
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=101 %}

= Evalastion Details

\fveerrhaninn = EM;J.(I:H mastchesd) in Talsa'

4.1.7.

I:lDLtur!ﬁlll'lml'.ln'\'ﬂ

[ |

= Global Flags | |

Yiou can configuee the giobad flags used for the Fp— i.‘mrmh’ mapresson conplershere. The fags e || |

sticky’, e, they are savied a5 state when the wessis dosad |

T Flags [ carevicn squvaiencs [ Case rosnaive [ Comments [ potst Bw |

R Perl Flags [ Case rserates O exrendest Ormatine [ sngeire

A Ak Flaga: [ Coves mescsiive | |

1| Feges Flags: [ Carse rsentove: O ruiee DOleetat O bonoee Spasces e |

- __J—I Iartafiogeny Flags; [ Case nsentive 3 e " | sl
T

Busqueda de expresiones requlares en la bibl __ioteca

Se pueden buscar expresiones regulares previamente almacenadas en cualquiera de los libros de la

&
biblioteca utilizando el boton del menu rapido: ﬁ Se obtiene la siguiente ventana de busqueda:

E- Search Reg. Exp. Library &n

Soad1fur|
Searchin: [ Tle
[ Reg. Exp.
I Testtext
I” Description
~ Goures

oK

cancel |

En ella se puede buscar en el titulo, la expresién regular, el texto de prueba, la descripcién y el campo
fuentes. La operacion de busqueda se realizara sobre todos los libros de la biblioteca.

4.2

Vista de prueba de las expresiones regulares

La vista de pruebas de las expresiones regulares (QuickREx view) permite comprobar que las
expresiones que definimos se ajustan a lo esperado. Para ello, comprueba al vuelo, si la opcién correspondiente
esta activada, el texto que se introduce en el campo: Test-text.
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En la siguiente figura se muestra la apariencia de la vista y se describen brevemente los elementos de la

misma: _ .
2 Problems | &) Tasks | @ web Browser | K Consale | 4 Servers | i History |-« QuidkREx 25
Regular Expresshon: |'Ld-!8}[.ﬂ.-za-:] 1
Test-Text: 5
2
= Evhluation Details -
]
[ Uve-evaustion [0 | Motcher matchest) i False'
Matches:
Groups;
= Global Flags
el can configure the global flags usad for the ereation of the regular-expeesson comprlers here, The Fflags are 'sticky’, i.&, they are caved &0 state when the view =
closad,
0¥ Flags: Dcm&wme O case nsenstive DCu'rmnm O potall B e [ Unicods case [ Urex ires 7
RO Perl Flags: [ Case insersitive [ Extended O mutiine - [ Sinlelne
(ORO Awk: Flags: [ Case insersitive
Regex Flags: [ case insersitive [ Mudtiine [ ocran [ torore Spaces [ Unicode [ %ML Schema
Jakarta-Regenp Flags: [ Case insersitive [ Matiine

1. Botones para navegar hacia delante y atras entre las partes del texto de prueba que se adaptan a
la expresion regular.

2. Siesta marcado, valida automaticamente el texto de pruebas.

3. Sino esta marcada la opcion ‘Live-evaluation’ sirve para provocar la validacion del texto de
pruebas.

4. Campo para editar la expresién regular.

5. Campo para modificar el texto de pruebas.

6. Boton que lleva al asistente de edicion de expresiones regulares.

7. Ademas de poder activar las opciones del motor de expresiones regulares, en linea, en la misma
expresioén regular. También se pueden utilizar las opciones de ‘Global Flags’ para hacerlo de una
manera mas clara y sencilla.

Como se dijo anteriormente en este manual, QuickREXx ofrece la posibilidad de usar los motores
de expresiones regulares mas comunmente utilizados. Asi pues, también se pueden activar las
opciones globales en funcion de la implementacion utilizada (JDK, ORO Perl, ORO Awk, JRegex,
Yakarta Regexp).
8. Botones para seleccionar la implementacion con la que se probara la expresion regular.
4.2.1. Asistente en linea

Al igual que en otros editores de Eclipse, en el campo de edicion de expresiones regulares del plug-in
QuickREXx puede utilizarse un asistente en linea que ayude a completar la expresion. Para conseguir una lista de
propuestas que ofrece QuickREXx, hay que pulsar ‘ctrl.+barra espaciadora’ mientras se edita la expresién en el
campo de edicion. Se abrira un asistente, tal como muestra la siguiente figura:
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E] i e Eusko i Informatika

T-_IH‘HJRR:

Regular Expression: ] p

In Unicode-block U
Uppercase Letter (Unicode)
Currency symbol (Unicode)
Lower-case alphabatic (US-A5CIT)
Upper-case alphabetic (US-ASCIT)
§ US-ASCH
Alphabetic (US-A5CTT)
« Evaluation Details Digit (US-A5CIT)
Alphanumeric (US-A5CTT)
[ ive-evabuation [© punctuation (US-ASCIT)
wisible (US-ASCIT)
Matches: [E1 prictable (us-ascir)

Test-Text:

block names are dafined in

& [ip{InU} - & character in the block U
| (

Ebp: ffwvove. unicode, argfPublicf3, 0-UpdatefBlocks-3.t
ISpaces removed such that ‘Basic Latin' s to be
used as \p{InBasicLatin etc.)

Groups:

Conforme se van seleccionando las diferentes propuestas, en el panel de la derecha va cambiando la
descripcion de la propuesta. Pulsando doble clic sobre la propuesta, es trasladada al campo de edicion,
completando nuestra expresion regular. Dada la complejidad de las expresiones regulares, no se puede afirmar
gue se muestran todas las propuestas posibles, pero si unas cuantas que ayudan a la creacion de la expresion

regular.
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